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Keysight 2-Port/4-Port 
N524xA to N524xB and 
N5264A to N5264B Model 
PNA-X Upgrade Kit 
- Installation Guide
This manual provides documentation for the following 
models: N524xA and N5264A
To Upgrade 2-Port/4-Port “A” models to 2-Port/4-Port 
“B” models

N5241AU-690 /N5241AU-691 (For N5241B), 
N5242AU-690 /N5242AU-691 (For N5242B), 
N5244AU-690 /N5244AU-691 (For N5244B), 
N5245AU-690 /N5245AU-691 (For N5245B), 

N5247AU-690 /N5247AU-691 (For 
N5247B), N5249AU-690 /N5249AU-691 (For N5249B), 
and 
N5264AU-690 /N5264AU-691 (For N5264B)
Upgrade Kit Numbers: N5242-60117 /N5242-60129, 
N5245-60116 /N5245-60134, N5247-60114 /
N5247-60119, N5264-60102 /N5264-60103

This is the Installation Note for the PNA-X N524xA Series Microwave Network Analyzers and 
N5264A Microwave Receiver.

http://www.keysight.com/
http://www.keysight.com/
https://www.keysight.com/us/en/assets/9921-01766/user-manuals/Users-Guide-A-Series-N991xA-2xA-3xA-5xA-6xA-Unabridged.pdf
https://www.keysight.com/us/en/assets/9921-01766/user-manuals/Users-Guide-A-Series-N991xA-2xA-3xA-5xA-6xA-Unabridged.pdf
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Warranty

THE MATERIAL CONTAINED IN THIS 
DOCUMENT IS PROVIDED “AS IS,” 
AND IS SUBJECT TO BEING 
CHANGED, WITHOUT NOTICE, IN 
FUTURE EDITIONS. FURTHER, TO 
THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, KEYSIGHT 
DISCLAIMS ALL WARRANTIES, 
EITHER EXPRESS OR IMPLIED WITH 
REGARD TO THIS MANUAL AND 
ANY INFORMATION CONTAINED 
HEREIN, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED 
WARRANTIES OF 
MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. 
KEYSIGHT SHALL NOT BE LIABLE 
FOR ERRORS OR FOR INCIDENTAL 
OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH THE 
FURNISHING, USE, OR 
PERFORMANCE OF THIS 
DOCUMENT OR ANY INFORMATION 
CONTAINED HEREIN. SHOULD 
KEYSIGHT AND THE USER HAVE A 
SEPARATE WRITTEN AGREEMENT 

WITH WARRANTY TERMS 
COVERING THE MATERIAL IN THIS 
DOCUMENT THAT CONFLICT WITH 
THESE TERMS, THE WARRANTY 
TERMS IN THE SEPARATE 
AGREEMENT WILL CONTROL.

Technology Licenses

The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance 
with the terms of such license.

U.S. Government Rights

The Software is “commercial 
computer software,” as defined 
by Federal Acquisition Regulation 
(“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and 
Department of Defense FAR 
Supplement (“DFARS”) 227.7202, 
the U.S. government acquires 
commercial computer software 
under the same terms by which 
the software is customarily 
provided to the public. 
Accordingly, Keysight provides 
the Software to U.S. government 
customers under its standard 
commercial license, which is 
embodied in its End User License 
Agreement (EULA), a copy of 
which can be found at 
http://www.keysight.com/find/sweula
The license set forth in the EULA 
represents the exclusive authority 
by which the U.S. government 
may use, modify, distribute, or 
disclose the Software. The EULA 
and the license set forth therein, 
does not require or permit, 
among other things, that 
Keysight: (1) Furnish technical 
information related to 
commercial computer software 
or commercial computer 
software documentation that is 
not customarily provided to the 
public; or (2) Relinquish to, or 
otherwise provide, the 
government rights in excess of 
these rights customarily provided 
to the public to use, modify, 
reproduce, release, perform, 
display, or disclose commercial 
computer software or 

commercial computer software 
documentation. No additional 
government requirements 
beyond those set forth in the 
EULA shall apply, except to the 
extent that those terms, rights, or 
licenses are explicitly required 
from all providers of commercial 
computer software pursuant to 
the FAR and the DFARS and are 
set forth specifically in writing 
elsewhere in the EULA. Keysight 
shall be under no obligation to 
update, revise or otherwise 
modify the Software. With 
respect to any technical data as 
defined by FAR 2.101, pursuant 
to FAR 12.211 and 27.404.2 and 
DFARS 227.7102, the U.S. 
government acquires no greater 
than Limited Rights as defined in 
FAR 27.401 or DFAR 227.7103-5 
(c), as applicable in any technical 
data.

Safety Notices

A CAUTION notice denotes a hazard. It 
calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. Do 
not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.

http://www.keysight.com/find/sweula
http://www.keysight.com/find/sweula
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Keysight Licensed Functionality Upgrade Kit
Upgrade Kit Numbers: N5242-60117, N5245-60116, N5247-60114, 
N5264-60102
Installation Note

Description of this Upgrade
This upgrade converts your N52xxA microwave network analyzer or N5264A 
microwave receiver to an equivalent N52xxB or N5264B running the Windows 
10 operating system. This is done by removing the existing front panel 
assembly, outer covers, and installing a new front panel assembly, SSDA, and 
outer covers.

As part of this upgrade, there are other assemblies that need to be verified, 
because the boards must be of a certain type to be compatible with the B 
model upgrade. Refer to “Initial Instrument Inspection” on page 22.

After installation of this upgrade, your analyzer will be a “B” model rather than 
an “A” model.

Option 690 is for N52xxA models which already contain the version 7 CPU. 
Option 691 is for N52xxA models which need the CPU upgraded to the latest 
version.

Refer to “Overview of the Installation Procedure” on page 27.

STOP! This repair must be done at a service center or self-maintainer! 
Refer to “Getting Assistance from Keysight” on page 6.

IMPORTANT! As part of the upgrade, the service center needs a copy of 
the customer’s Keysight License files that were sent to them from 
Keysight. Refer to “License Key File Redemption” on page 7.

IMPORTANT! N5244/5A PNAs with H29 cannot upgrade to N5244/5B.

Included in the contents of this kit is a Software Entitlement Certificate with 
instructions on how to redeem it. Do NOT attempt to redeem this certificate 
until you have read “License Key File Redemption” on page 7.

For additional information on using the Keysight Software Manager and 
redeeming a Software Entitlement Certificate, refer to 
https://www.keysight.com/us/en/assets/9018-04534/installation-guides
/9018-04534.pdf (N5242-90024).

https://www.keysight.com/us/en/assets/9018-04534/installation-guides/9018-04534.pdf
https://www.keysight.com/us/en/assets/9018-04534/installation-guides/9018-04534.pdf
https://www.keysight.com/us/en/assets/9018-04534/installation-guides/9018-04534.pdf 
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Description of this Upgrade
Getting Assistance from Keysight

-

Getting Assistance from Keysight
Installing this upgrade kit requires special skills and experience. If you think 
you may not be qualified to do the work, or need advice, contact Keysight.

Contacting Keysight

Assistance with test and measurements needs and information on finding a 
local Keysight office are available on the Web at: 
http://www.keysight.com/find/assist

If you do not have access to the Internet, please contact your Keysight field 
engineer.

If You Have Problems With the Upgrade Kit Contents

Keysight stands behind the quality of the upgrade kit contents. If you have 
problems with any item in the kit, refer to www.keysight.com and the Contact 
US.

In any correspondence or telephone conversation, refer to the Keysight 
product by its model number and full serial number. With this information, 
the Keysight representative can determine whether your product is still 
within its warranty period.

http://www.keysight.com/find/assist
http://www.keysight.com/find/assist
http://www.keysight.com/find/assist
www.keysight.com
www.keysight.com
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Description of this Upgrade
Getting Prepared

Getting Prepared

License Key File Redemption

To upgrade model(s), you must request an Option 690/691 license key file from 
the Keysight Software Manager: 
http://www.keysight.com/find/softwaremanager:

To complete the request, you will need to gather the following information:

— From the certificate

— Order number

— Certificate number

— From your instrument 

(Instrument information is available in the network analyzer - on the 
toolbar, click Help, then click About Network Analyzer.)

— Model number

— Serial number

Using the information just gathered, you must request license key file from the 
Keysight Software Manager: 
http://www.keysight.com/find/softwaremanager.

The following Keysight Software Manager (KSM) procedure has been 
added—but is abbreviated—for users that are familiar with the KSM process and 
has steps that are specific to the A model to B model upgrade 
(Option 690/691).

IMPORTANT! As part of the upgrade, the service center needs to 
request a the customer’s Keysight License files from Keysight. Refer to 
“License Key File Redemption” on page 7.

IMPORTANT! Also, you will need to contact the Keysight factory support 
node to request multiple license key files. Refer to “Obtain Multiple 
License Key Files” on page 9.

Ensure that you are connected to an external server, before attempting to 
download your email and license key file. 

The enclosed Software Entitlement Certificate is a receipt, verifying that 
you have purchased a licensed option for the analyzer of your choice. You 
must now use a Keysight Web page to request a license key file for the 
instrument that will receive the option. 

https://:www.software.keysight.com/find/softwaremanager
https://:www.software.keysight.com/find/softwaremanager
https://:www.software.keysight.com/find/softwaremanager
https://:www.software.keysight.com/find/softwaremanager
http://www.keysight.com/find/softwaremanager
http://www.keysight.com/find/softwaremanager
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Description of this Upgrade
Getting Prepared

-

1. Enter your login and password or setup a login as required.

2. In the Keysight License Manager welcome window, click You can add a 
new certificate.

3. In the “Keysight Software Manager: Add Certificate” window that opens, in 
the “Enter your certificate information” section, refer to your Software 
License Certificate that you received with your upgrade kit and enter the 
following:

— Order Number

— Certificate Number

4. Click Continue (to return to the Keysight Software Manager welcome 
screen).

5. If there are multiple “A” model PNAs that are being upgraded to a “B” 
model, repeat steps 3 and 4.

Else, continue to next step. 

6. In the Keysight Software Manager welcome screen, click “You can request 
new licenses”.

7. In the “Keysight Software Manager: Request Licenses” window that opens, 
in the “Select the host to assign licenses to” section, click the Click to add 
or select a host drop-down.

8. Click Add a new License Notifier Host ID host...

9.  In the License Notifier Host ID: box that is displayed, enter your 
instrument’s model and serial number, separated by only a comma—no 
spaces). Example: 

—  New License Host Notifier Host ID host: N5242A,MY12345678
—  The Model number suffix should always be “A” (i.e., NOT “AS”, and 

NOT “B”)

10. In the Select the licenses to assign section, scroll down until you see a 
Option 690 or Option 691 upgrade with your instrument’s “A” and “B” 
model values— similar to this example—and then click the box to select:

— N5247AU-690 Upgrade N5247A to N5247B

11. Click Assign Licenses

12. In the “Assigned licenses:” section that opens, listing all of the License 
Notifier Host IDs and associated instrument information, verify the 
following:

IMPORTANT: To avoid the loss of an option license, ensure that you only 
have a single Option 690/691 upgrade checked. 
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Description of this Upgrade
Getting Prepared

—  License Notifier Host ID: contains the correct “B” model and serial 
number

— the associated N52xxAU-690 Upgrade or N52xxAU-691 Upgrade 
lists the correct “A” model to “B” model

If any of the information listed in the “Assigned licenses:” section is 
incorrect, click Remove next to the incorrect License Notifier Host ID: or 
N52xxAU-690 or N52xxAU-691 Upgrade to remove them from the 
“Assigned Licenses” list.

13. If there are multiple “A” model PNAs that are being upgraded to a “B” 
model, repeat steps 7 through 12.

Else, continue to next step. 

14. Once you have verified the License Notifier Host ID & N52xxAU-690 or 
N52xxAU-691 Upgrade Option models are correct, click Continue > (an 
email is sent to you with an Option 690 or Option 691 license file for each 
specific License Notifier Host ID’d PNA).

15. Keysight will promptly email your license key file(s) to your profile’s email 
address. 

Obtain Multiple License Key Files

All of the licenses in your instrument need to be converted to a new format for 
your “B” model instrument. Contact Keysight Technologies factory support 
early in your upgrade process to receive your licenses in a timely manner. See 
“Getting Assistance from Keysight” on page 6.

You will need to provide Keysight with the following information:

— model number

— serial number

— email address of the technician performing this upgrade (i.e., to send the 
license key files)

Verify the License Contents 

Refer to the license message you received from Keysight: 

If the model number, serial number, or option number do not match those on 
the license message you received from Keysight, you will not be able to install 
the license key file. If this is the case, contact Keysight for assistance. Refer to 
“Description of this Upgrade” on page 5.



 10                                                                                                                               Installation Note N5242-90023

Description of this Upgrade
Protecting Your Workspace from Electrostatic Discharge
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Downloading the Online PNA Service Guide

To view the Service Guide for your PNA model number, use the following steps:

1. Go to www.keysight.com.

2. In the Search box, enter the model number of the analyzer (e.g., N5232B) 
and click Search.

3. Click Support > Keysight Product Support.

4. In the Search Support area type your instrument’s model number (e.g., 
N2245B).

5. Press Enter. 

6. Scroll down to the PRINT DOCUMENTATION section and click to select 
Service Manual.

The Service Manual for your instrument will be displayed near the top of 
the right column.

7. Click the hyperlink of the Service Guide title to download the PDF file.

8. When the PDF of the Service Guide is displayed, scroll through the 
Contents section bookmarks to locate the information needed. 

Protecting Your Workspace from Electrostatic Discharge
For information, click on the Chapter 1 bookmark, “Electrostatic Discharge 
Protection” in the PDF of your instrument’s Service Guide on 
www.keysight.com1.

ESD Equipment Required for the Installation

1. See “Downloading the Online PNA Service Guide” on page 10.

Description Keysight Part Number

ESD grounding wrist strap 9300-1367

5-ft grounding cord for wrist strap 9300-0980

2 x 4 ft conductive table mat and 15-ft grounding wire 9300-0797

ESD heel strap (for use with conductive floors) 9300-1308

http://www.keysight.com
http://www.keysight.com/
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Description of this Upgrade
Tools Required for the Installation

Tools Required for the Installation

About Installing the Upgrade

Description Qty

T-10 TORX driver - set to 9 in-lbs (1.02 N.m) 1

T-20 TORX driver - set to 21 in-lbs (2.38 N.m) 1

5/16-in (8 mm) nutsetter or open end torque wrench - set to 10 in-lbs (1.13 N.m) 1

5/16-in (8 mm) nutsetter or open end torque wrench - set to 21 in-lbs (2.38 N.m) 1

9 mm nutsetter or open end torque wrench - set to 21 in-lbs) (2.38 N.m) 1

1/4-in (6 mm) open end wrench 1

Use a 5/16-in torque wrench set to 10 in-lbs on all cable connections 
except the front and rear panel bulkhead connectors. On these, use a 
9 mm nutsetter or open end torque wrench set to 21 in-lb.

Products affected All N524xA microwave network analyzers and all N5264A 
microwave receivers 

Installation to be performed by Keysight service center, personnel qualified by Keysight, or 
customer

Estimated installation time 4 hours 

Estimated adjustment time 1.5 hours

Estimated full instrument calibration time 4.5 to 8.0 hours
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Description of this Upgrade
Items Included in the Upgrade Kit
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Items Included in the Upgrade Kit
Check the contents of your kit against the following list. If any part is missing or 
damaged, contact Keysight Technologies. Refer to “Description of this 
Upgrade” on page 5.

There are two CPU version part numbers listed in the upgrade kit tables 
below. 

– W1312-60211 is the legacy version 7 CPU that some units have already 
installed. It is NOT being replaced and it is NOT included in Option 690 
upgrade kit.

– W1312-60563 is current Version 9 CPU for Windows 10 upgrades in the 
N523xAU-691 upgrade kits. This CPU is included in the Option 691 
upgrade kit.

Please verify your CPU version and your upgrade kit part number before 
you begin this procedure.

This section applies to multiple models and upgrade kits. Please refer to 
the model and upgrade kit for your instrument’s upgrade.

Extra quantities of items such as protective plastic caps, screws, cable ties, 
and cable clamps may be included in this upgrade kit. It is normal for some 
of these items to remain unused after the upgrade is completed.

Table 1 Contents of Upgrade Kit N5242-60117/N5242-60129 for N5241AU-690/691 
(N5241B), N5242AU-690/691 (N5242B), and N5249AU-690/691 (N5249B)

Qty Description  Part Number

1 Installation Note (this document) N5242-90023

1 Software Entitlement Certificate 5964-5145

2 Front handle 5023-3074

4 Rear foot 5041-7903

4 Bottom foot 5041-7906

2 Trim strip, side, phantom gray 5041-7908

1 Caution label 5190-1799

1 Win 10 IoT Ent 2019 LTSC MultiLang ESD OEI EPKEA Value 9010-0350

1 China RoHS Addendum 9320-6722

1 Front frame – (assembly) N5240-60071

4 Machine screw, M4.0 x 25 pan head (To attach rear feet to chassis.) 0515-1619
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Description of this Upgrade
Items Included in the Upgrade Kit

14
Machine screw, M3.0 x 10 mm flat head (To attach lower dress panel overlay frame to 
chassis).

0515-1946

12 Machine screw, M4.0 x 10 flat head (To attach front frame to chassis.) 0515-2044

1 Cable Assembly–Flat Ribbon 230 mm LG - Handler I/O cable (LFE) 8121-2919

1 Solid-state drive assembly (SSDA) – Option 690 only N5242-601351

Solid-state drive assembly (SSDA) – Option 691 only N5242-601372

1 Lower front panel overlay, 2-port (N5241/2/9B Options 201/219) N5222-80010 

Lower front panel overlay, 2-port (N5241/2/9B Option 224) N5242-80024 

Lower front panel overlay, 4-port (N5241/2/9B Option 401/419 /423) N5222-80013 

Lower front panel overlay, 2-port (N5241/2/9B Option 219 with Option 029) N5242-80026 

Lower front panel overlay, 2-port (N5241/2/9B Option 224 with Option 029) N5242-80027 

Lower front panel overlay, 4-port (N5241/2/9B Option 419/423 with Option 029) N5242-80028 

Lower front panel overlay, 2-port (N5241/2/9B Option 217) N5242-80029 

Lower front panel overlay, 2-port (N5241/2/9B Option 222) N5242-80030 

Lower front panel overlay, 4-port (N5241/2/9B Option 417 or 422)        N5242-80031

Lower front panel overlay, 2-port (N5241/2/9B Option 217 with Option 029) N5242-80032

Lower front panel overlay, 2-port (N5241/2/9B Option 222 with Option 029) N5242-80033

Lower front panel overlay, 4-port (N5241/2/9B Option 417/422 with Option 029) N5242-80034

1 Nameplate, N5241B N5241-80002

Nameplate, N5242B N5242-80022

Nameplate, N5249B N5249-80003

1
Lower Dress Panel, 2-Port (ALL PNA models). Goes on, before lower front panel 
overlay. Attach with 0515-1946 subpanel screws.

N5240-00010

Lower Dress Panel, 4-Port (ALL PNA models). Goes on, before lower front panel 
overlay. Attach with 0515-1946 subpanel screws.

N5240-00009

1 Rear panel, power supply N5240-00012

1 Cable, assembly 60C 30 AWG 60F 60F N5240-60090

1 Label, KCC N5240-80041

2 Guard, jumper cables, side—2-Port & 4-Port N5242-00048

1 Outer cover N5242-00047

Table 1 Contents of Upgrade Kit N5242-60117/N5242-60129 for N5241AU-690/691 
(N5241B), N5242AU-690/691 (N5242B), and N5249AU-690/691 (N5249B)

Qty Description  Part Number
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Description of this Upgrade
Items Included in the Upgrade Kit

-

1 Guard, jumper cables, center—4-Port N5242-00049

1 Front impact cover N9040-40007

1 Rear impact cover N9040-40008

2 Strap handle assembly N5242-60076

4 Key lock (for bottom foot) 5021-2840

1 Version 9 CPU kit (Option 691 only) W1312-60563

Not Included - (For Reference Only) - External Hard ware and Miscellaneous Parts, All Options

4 Machine screw M5.0 x 18, flat head (To attach strap handle.) 0515-0710

4 Hole plug (When analyzer is rack mounted.) N9020-40007

1 Test set, subpanel (2-port)3 - N5241/2/9B only N5221-00006

1 Test set, subpanel (4-port)3 - N5241/2/9B only N5221-00007

1 Wire assy, LED PCA3 - N5241/2/9B only N5242-60009

1 Synthesizer board (With tabs for s/n 5200 and above) N5240-60074

Synthesizer board (Without tabs for s/n’s below 5200) N5240-60076

1 Synthesizer board kit (Without tabs for s/n’s below 5200) – Qty is 3 boards N5242-60168

1 DSP (SPAM) version 5 board N5240-60077

1 DSP (SPAM) cable (2-port only) N5247-60023

DSP (SPAM) cable (2-port only) N5247-60024

DSP (SPAM) cable (All) N5242-60014

1 IF Multiplexer board N5240-60062

n/a
Version 7 CPU – is already installed on some instruments. It can be upgraded to 
Windows 10 OS using SSDA N5242-60135, but this legacy CPU is not part of the 
Option 690 upgrade kit. This p/n is included for your reference only.

W1312-602111

1. Version 7 SSDA for use only with the version 7 CPU.  The version 7 CPU is not part of the Option 690 upgrade kit, but 
is required to use N5242-60135 Windows 10 OS SSDA. If an instrument has an older CPU than version 7 
W1312-60211, the customer must order Option 691 to upgrade to a B model.

2. Version 9 SSDA for use only with the Version 9 CPU.  The Version 9 CPU is included in the Option 691 upgrade kit.
3. If it is necessary to replace these parts, Keysight will replace these parts at no cost to the customer.

Table 1 Contents of Upgrade Kit N5242-60117/N5242-60129 for N5241AU-690/691 
(N5241B), N5242AU-690/691 (N5242B), and N5249AU-690/691 (N5249B)

Qty Description  Part Number
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Description of this Upgrade
Items Included in the Upgrade Kit

Table 2 Contents of Upgrade Kit N5245-60116/N5245-60134 for N5244AU-690/691 
(N5244B) and N5245AU-690/691 (N5245B)

Qty Description  Part Number

1 Installation Note (this document) N5242-90023

1 Software Entitlement Certificate 5964-5145

2 Front handle 5023-3074

4 Rear foot 5041-7903

4 Bottom foot 5041-7906

2 Trim strip, side, phantom gray 5041-7908

1 Caution label 5190-1799

1 Win 10 IoT Ent 2019 LTSC MultiLang ESD OEI EPKEA Value 9010-0350

1 China RoHS Addendum 9320-6722

1 Front frame – (assembly) N5240-60071

4 Machine screw, M4.0 x 25 pan head (To attach rear feet to chassis.) 0515-1619

14
Machine screw, M3.0 x 10 mm flat head (To attach lower dress panel overlay frame to 
chassis).

0515-1946

12 Machine screw, M4.0 x 12 flat head (To attach front frame to chassis.) 0515-2044

1 Cable Assembly–Flat Ribbon 230 mm LG - Handler I/O cable (LFE) 8121-2919

1 Solid-state drive assembly (SSDA) – Option 690 only N5242-601351

Solid-state drive assembly (SSDA) – Option 691 only N5242-601372

1 Lower front panel overlay, 2-port (N5244/5B Options 201/219) N5242-80023 

Lower front panel overlay, 2-port (N5244/5B Option 224) N5245-80027

Lower front panel overlay, 4-port (N5244/5B Option 401/419 /423) N5242-80025 

Lower front panel overlay, 2-port (N5244/5B Option 222) N5245-80028

Lower front panel overlay, 2-port (N5244/5B Option 224 with Option 029) N5245-80029

Lower front panel overlay, 4-port (N5244/5B Option 423 with Option 029) N5245-80030 

Lower front panel overlay, 2-port (N5244/5B Option 217) N5242-80029 

Lower front panel overlay, 4-port (N5244/5B Option 417/422)        N5242-80031

Lower front panel overlay, 2-port (N5244/5B Option 222 with Options 029) N5245-80033

Lower front panel overlay, 4-port (N5244/5B Option 417/422 with Options 029) N5245-80031

1 Nameplate, N5244B N5244-80002

Nameplate, N5245B N5245-80026
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1
Lower Dress Panel, 2-Port (ALL PNA models). Goes on, before lower front panel 
overlay. Attach with 0515-1946 subpanel screws.

N5240-00010

Lower Dress Panel, 4-Port (ALL PNA models). Goes on, before lower front panel 
overlay. Attach with 0515-1946 subpanel screws.

N5240-00009

1 Rear panel, power supply N5240-00012

1 Cable, assembly 60C 30 AWG 60F 60F N5240-60090

1 Label, KCC n5240-80041

1 Outer cover N5245-00035

2 Guard, jumper cables, side—2-Port & 4-Port N5242-00048

1 Guard, jumper cables, center—4-Port N5242-00049

1 Front impact cover N9040-40007

1 Rear impact cover N9040-40008

2 Strap handle assembly N5247-60030

4 Key lock (for bottom foot) 5021-2840

1 Version 9 CPU kit (Option 691 only) W1312-60563

Not Included - (For Reference Only) - External Hard ware and Miscellaneous Parts, All Options

4 Machine screw M5.0 x 18, flat head (To attach strap handle.) 0515-0710

4 Hole plug (When analyzer is rack mounted.) N9020-40007

1 Synthesizer board (With tabs for s/n 5200 and above) N5240-60074

Synthesizer board (Without tabs for s/n’s below 5200) N5240-60076

1 Synthesizer board kit (Without tabs for s/n’s below 5200) – Qty is 3 boards N5242-60168

1 DSP (SPAM) version 5 board N5240-60077

1 DSP (SPAM) cable (2-port only) N5247-60023

DSP (SPAM) cable (2-port only) N5247-60024

DSP (SPAM) cable (All) N5242-60014

1 IF Multiplexer board N5240-60062

1 Test set, subpanel (2-port)3 - N5244/45B only N5224-00004

Test set, subpanel (4-port)3 - N5244/45B only N5224-00005

1 Wire assy, LED PCA3 - N5244/45B only N5225-60001

Table 2 Contents of Upgrade Kit N5245-60116/N5245-60134 for N5244AU-690/691 
(N5244B) and N5245AU-690/691 (N5245B)

Qty Description  Part Number
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Description of this Upgrade
Items Included in the Upgrade Kit

n/a
Version 7 CPU – is already installed on some instruments. It can be upgraded to 
Windows 10 OS using SSDA N5242-60135, but the legacy CPU is not part of the 
Option 690 upgrade kit. This p/n is included for reference only.

W1312-602111

1. Version 7 SSDA for use only with the version 7 CPU.  The version 7 CPU is not part of the Option 690 upgrade kit, but 
is required to use N5242-60135 Windows 10 OS SSDA. If an instrument has an older CPU than version 7 
W1312-60211, the customer must order Option 691 to upgrade to a B model.

2. Version 9 SSDA for use only with the Version 9 CPU.  The Version 9 CPU is included in the Option 691 upgrade kit.
3. If it is necessary to replace these parts, Keysight will replace these parts at no cost to the customer.

Table 2 Contents of Upgrade Kit N5245-60116/N5245-60134 for N5244AU-690/691 
(N5244B) and N5245AU-690/691 (N5245B)

Qty Description  Part Number
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Description of this Upgrade
Items Included in the Upgrade Kit

-

Table 3 Contents of Upgrade Kit N5247-60114/N5247-60119 for N5247AU-690/691 
(N5247B))

Qty Description  Part Number

1 Installation Note (this document) N5242-90023

1 Software Entitlement Certificate 5964-5145

1 Front frame – (assembly) N5240-60071

4 Machine screw, M4.0 x 25 pan head (To attach rear feet to chassis.) 0515-1619

14
Machine screw, M3.0 x 10 mm flat head (To attach lower dress panel overlay frame to 
chassis).

0515-1946

12 Machine screw, M4.0 x 12 flat head (To attach front frame to chassis.) 0515-2044

1 Win 10 IoT Ent 2019 LTSC MultiLang ESD OEI EPKEA Value 9010-0350

1 China RoHS Addendum 9320-6722

1 Solid-state drive assembly (SSDA) – Option 690 only N5242-601351

Solid-state drive assembly (SSDA) – Option 691 only N5242-601372

2 Front handle 5023-3074

4 Rear foot 5041-7903

4 Bottom foot 5041-7906

2 Trim strip, filler (For analyzers without handles.) 5041-7908

1 Two person Caution label 5190-1799

1 Cable Assembly–Flat Ribbon 230 mm LG - Handler I/O cable (LFE) 8121-2919

1 Lower front panel overlay, 2-port (N5247B Options 201 or 219) N5247-80020 

Lower front panel overlay, 2-port (N5247B Option 224) N5247-80018

Lower front panel overlay, 4-port (N5247B Option 401 or 419) N5247-80021 

Lower front panel overlay, 2-port (N5247B Option 423) N5247-80019 

Lower front panel overlay, 2-port (N5247B Option 224 with Option 029) N5247-80022

Lower front panel overlay, 4-port (N5247B Option 423 with Option 029) N5247-80023 

1 Nameplate, N5247B N5247-80017

1
Lower Dress Panel, 2-Port (ALL PNA models). Goes on, before lower front panel 
overlay. Attach with 0515-1946 subpanel screws.

N5240-00010

Lower Dress Panel, 4-Port (ALL PNA models). Goes on, before lower front panel 
overlay. Attach with 0515-1946 subpanel screws.

N5240-00009

1 Rear panel, power supply N5240-00012

1 Cable, assembly 60C 30 AWG 60F 60F N5240-60090
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Items Included in the Upgrade Kit

1 Label, KCC N5240-80041

1 Outer cover N5245-00035

2 Guard, jumper cables, side—2-Port & 4-Port N5242-00048

1 Guard, jumper cables, center—4-Port N5242-00049

1 Guard, jumper cables, center—4-Port N5247-00024

1 Front impact cover N9040-40007

1 Rear impact cover N9040-40008

2 Strap handle assembly N5247-60030

1 Guard, dual rear jumper cable cover N5247-00027

4 Key lock (for bottom foot) 5021-2840

1 Version 9 CPU kit (Option 691 only) W1312-60563

Not Included - (For Reference Only) - External Hard ware and Miscellaneous Parts, All Options

4 Machine screw M5.0 x 18, flat head (To attach strap handle.) 0515-0710

4 Hole plug (When analyzer is rack mounted.) N9020-40007

1

1

Synthesizer board (With tabs for s/n 5200 and above) N5240-60074

Synthesizer board (Without tabs for s/n’s below 5200) N5240-60076

1 Synthesizer board kit (Without tabs for s/n’s below 5200) – Qty is 3 boards N5242-60168

1 DSP (SPAM) version 5 board N5240-60077

1 DSP (SPAM) cable (2-port only) N5247-60023

DSP (SPAM) cable (2-port only) N5247-60024

DSP (SPAM) cable (All) N5242-60014

1 IF Multiplexer board N5240-60062

n/a
Version 7 CPU – is already installed on some instruments. It can be upgraded to 
Windows 10 OS using SSDA N5242-60135, but the legacy CPU is not part of the 
Option 690 upgrade kit. This p/n is included for reference only.

W1312-602111

1. Version 7 SSDA for use only with the version 7 CPU.  The version 7 CPU is not part of the Option 690 upgrade kit, but 
is required to use N5242-60135 Windows 10 OS SSDA. If an instrument has an older CPU than version 7 
W1312-60211, the customer must order Option 691 to upgrade to a B model.

2. Version 9 SSDA for use only with the Version 9 CPU.  The Version 9 CPU is included in the Option 691 upgrade kit.

Table 3 Contents of Upgrade Kit N5247-60114/N5247-60119 for N5247AU-690/691 
(N5247B))

Qty Description  Part Number
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Description of this Upgrade
Items Included in the Upgrade Kit

-

Table 4 Contents of Upgrade Kit N5264-60102/N5264-60103 for N5264AU-690/691 
(N5264B)

Qty Description  Part Number

1 Installation Note (this document) N5242-90023

1 Software Entitlement Certificate 5964-5145

1 Front frame – (assembly) N5240-60071

4 Machine screw, M4.0 x 25 pan head (To attach rear feet to chassis.) 0515-1619

10
Machine screw, M3.0 x 10 mm flat head (To attach lower dress panel overlay frame to 
chassis).

0515-1946

12 Machine screw, M4.0 x 12 flat head (To attach front frame to chassis.) 0515-2044

1 Win 10 IoT Ent 2019 LTSC MultiLang ESD OEI EPKEA Value 9010-0350

1 China RoHS Addendum 9320-6722

1 Solid-state drive assembly (SSDA) – Option 690 only N5242-601351

Solid-state drive assembly (SSDA) – Option 691 only N5242-601372

2 Front handle 5023-3074

4 Rear foot 5041-7903

4 Bottom foot 5041-7906

2 Trim strip, filler (For analyzers without handles.) 5041-7908

1 Caution label 5190-1799

1 Cable assembly - flat ribbon 040C 40F/36 230mm-LG 8121-2919

1 Lower front panel overlay, N5264B N5264-80005

1 Nameplate, N5264B N5264-80004

1 Lower Dress Panel, attach with 0515-1946 subpanel screws. N5264-00005

1 Rear panel, power supply N5240-00012

1 Cable, assembly 60C 30 AWG 60F 60F N5240-60090

1 Outer cover N5242-00047

1 Front impact cover N9040-40007

1 Rear impact cover N9040-40008

2 Strap handle assembly N5242-60076

4 Key lock (for bottom foot) 5021-2840

1 Version 9 CPU kit (Option 691 only) W1312-60563

Not Included - (For Reference Only) - External Hard ware and Miscellaneous Parts, All Options
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Items Included in the Upgrade Kit

1 Machine screw M5.0 x 18, flat head (To attach strap handle.) 0515-0710

1 Hole plug (When analyzer is rack mounted.) N9020-40007

n/a
Version 7 CPU – is already installed on some instruments. It can be upgraded to 
Windows 10 OS using SSDA N5242-60135, but the legacy CPU is not part of the 
Option 690 upgrade kit. This p/n is included for reference only.

W1312-602111

1. Version 7 SSDA for use only with the version 7 CPU.  The version 7 CPU is not part of the Option 690 upgrade kit, but 
is required to use N5242-60135 Windows 10 OS SSDA. If an instrument has an older CPU than version 7 
W1312-60211, the customer must order Option 691 to upgrade to a B model.

2. Version 9 SSDA for use only with the Version 9 CPU.  The Version 9 CPU is included in the Option 691 upgrade kit.

Table 4 Contents of Upgrade Kit N5264-60102/N5264-60103 for N5264AU-690/691 
(N5264B)

Qty Description  Part Number
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Description of this Upgrade
Initial Instrument Inspection

-

Initial Instrument Inspection

The purpose of this section is to verify where the instrument should begin the 
model conversion process. This section verifies that the instrument has all of 
the required board assemblies for a B model upgrade.

If your instrument does not have all of the required board assemblies, contact 
the customer, to provide a quote on parts and labor. Upon customer approval, 
order up all of the new upgrade kits and boards, before the “B” model upgrade 
can be completed.

Refer to Table 5 on page 23 and then to “Verifying the Board Assemblies” on 
page 25.

STOP! This repair must be done at a service center! Refer to “Getting 
Assistance from Keysight” on page 6.

This section and all steps must be completed before proceeding to the 
following sections or customer data may be lost or instrument repair 
delayed!

STOP! 

Any return to factory (RTF) that will have CPU, Midplane, Motherboard, 
Front Panel, or Front Panel Ribbon replaced will need to have it's event log 
cleared after the hardware replacements are complete. 

Older System motherboards with serial numbers 
<N5247-63002-23-1945-00002 need to be reworked to remove L1, per 
Appendix C: “Motherboard Clearing the Event Log and Modification to 
Replace L1,” on page  77. If you have an older system board, call Keysight 
Support to verify, if your instrument has previously been upgraded. Refer 
to “Getting Assistance from Keysight” on page 6.

Before beginning this System Motherboard rework, refer to step 4, in 
“Verifying the Board Assemblies” on page 25.

STOP! 

If you ordered Option 690, your instrument requires a Version 7 CPU 
W1312-60211 to be able to use the Windows 10 Operating System SSDA 
N5242-60135. A version 7 CPU is not included with Option 690. If an 
instrument has an older CPU, then the customer must order Option 691 
that includes a Version 9 CPU, refer to Table 1 on page 12, Table 2 on 
page 15, Table 2 on page 15, Table 3 on page 18, Table 4 on page 20 and 
to “Contacting Keysight” on page 6. 
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Table 5 Overview of Assembly Requirements for B Model Upgrade  

Assembly1 Part Number Serial Number for PNAs that start using 
these boards (PNAs with these serial 
prefixes do not need to be upgraded) 

Can be 
ordered 
using the 
part number, 
or:

SPAM 5 N5240-60078 
For 2-port PNAs, also order x1 
N5247-60023 and x1 
N5247-60024

MY/US5200 and above N8989A-SP5

IF Multiplexer, version 
B

N5240-60062 MY/US5540 and above N889A-MX2

Synthesizers, versions 
E, F, or G

N5240-60076 (single board) or           MY/US5120 and above                                        N8989A-SR6

N5242-60168 (3 board kit)

2-port PNAs without option 224 need two synthesizer 
boards. 4-port PNAs or 2-port option 224 PNAs need 
three synthesizer boards.

Test Set Motherboard 
– N5241/2/9A & 
N5264A only

N5245-60163 MY/US4940 and above ––––

Test Set Motherboard 
– N5244/5A 
only2

N5245-60157 MY/US5240 and above ––––

System 
Motherboard3, 4, 5 
(See Critical Footnote)

N5247-60002 N5247-63002-23-1945-00002 and 
above

––––

Noise receiver board6 
 (Option 029 only) –

(See critical footnote)

N5245-60124 (5201 and above) MY/US5540 and above ––––

N5245-60125 (5150 and below) ––––

1. Critical Footnote:
      Any return to factory (RTF) that will have CPU, Midplane, Motherboard, Front Panel, or Front Panel Ribbon replaced will need to 

have it's event log cleared after the hardware replacements are complete. 
2. All of the N5247A PNA-X’s already have a N5245-60157 test set motherboard installed.  
3. Critical Footnote:  

Older System motherboards with serial numbers <N5247-63002-23-1945-00002 need to be reworked to remove L1, per 
Appendix C, "Motherboard Clearing the Event Log and Modification to Replace L1" on page  C-77. If 
you have an older system board, call Keysight Support to verify, if your instrument has previously been upgraded. Refer to 
“Getting Assistance from Keysight” on page page  6.

4. This is a system motherboard serial number break.
5. The system motherboards that require the L1 rework are only installed  in the PNA/PNA-X instruments (i.e., 

N5224/25/27/44/45/47A). 
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Description of this Upgrade
Initial Instrument Inspection

-

6. Critical Footnote: 
The older N5242-60098 noise recever board for the N5241A/42A currently works in the N5241B/42B. However, the 
functionality is not thorougly tested anymore when we release new firmware. There may come a time when the new firmware 
does not work with this older board, and the only option will be to upgrade the board. Upgrading now to the N5245-60124 
board will proacitvely prevent any furture firmware incompatibility. If the PNA serial number is below US/MY5200xxxx, upgrade 
to the N5245-60124 board by ordering the N5245-60125 kit. This provides the N5245-60124 and a replacement shield to allow 
the board to fit in the older chassis. Upgrading from the N5242-60098 to the N5245-60124 board also requires the W141 and 
W143 cables to be replaced. Order one each of cables N5242-20322 and N5242-20323. 
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Initial Instrument Inspection

Verifying the Board Assemblies

The following board assemblies need to be verified and installed during the 
upgrade:

1. Press Help > About NA...

2. In the About Network Analyzer window that opens, make a note of the 
following:

— System CPU Version

— The system CPU must be a version 7 or greater. Option 690 
is for PNAs that already have the version 7 CPU installed, 
you must have a W1312-60211 version 7 CPU installed, to 
use the N5242-60135 Win 10 OS SSDA. If a PNA has an 
older CPU version that needs to be replaced, the customer 

IMPORTANT! 

EPT labeled motherboards need to be replaced prior to proceeding with 
the upgrade (i.e., See image this note). Learn more, refer to the following 
Service Notes: N5221A-02A, N5222A-02A, N5224A-01A, N5225A-02A, 
N5227A01A, N5241A-03A, N5242A-07A, N5244A-03, N5245A-04A, and 
N5247A-02A.
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Description of this Upgrade
Initial Instrument Inspection

-

will need to order the Option 691 kit, which includes a 
Version 9 or greater CPU. Please contact Keysight if you 
need to order Option 691. 

— DSP Version

— The DSP (SPAM) board must be version 5 or greater. The 
SPAM V boards are not included in this kit. Please contact 
Keysight if you need to replace the SPAM boards and order 
N5240-60077 SPAM V and N5242-60014 (W61) IF cable. If 
you have a 2-Port instrument, you will also need to order 
one each of cable numbers: N5247-60023 and 
N5247-60024. 

3. Press Utility > System > Service > Diagnostics > EEPROM Headers

— Verify the LO Synth, Src1 Synth, and Src2 Synth boards part number 
is either “N524063074” or “N524263150”. The synthesizer boards 
are not included in this kit. Please contact Keysight if you need to 
replace the synthesizer boards and order N5240-60076.

— Option 029 only: Verify the “N524563124” noise receiver board 
EEPROM header revision reads: “B”. If the EEPROM reads “A”, edit 
the EEPROM to read “B”. 

4. If your system motherboard is <N5247-63002-23-1945-00002 and your 
board has not been already reworked by the factory, then you must 
perform the L1 modification, per Appendix C: “Motherboard Clearing the 
Event Log and Modification to Replace L1,” on page  77. If you suspect 
that you have an older system board, call Keysight Support to verify, if 
your instrument has previously been upgraded. Refer to “Getting 
Assistance from Keysight” on page 6.

Refer to the Service Guide for your model instrument and to “Removing 
and Replacing the A14 System Motherboard” in “Chapter 7 Repair and 
Replacement Procedures.”

5. Remove the instrument outer covers and if necessary the power supply, to 
verify the Midplane Board’s part number reads: “W1312-63376”. Refer to 
the Service Guide on www.keysight.com for removing the power supply. 

Then choose from the following:

IMPORTANT!

If you need to rework you system motherboard, do not reassemble your 
instrument until reviewing/completing step 5 below and the following step 
in the “Overview of the Installation Procedure” on page 27:

If applicable: 

— “Instruments with Windows 7 Operating System (Windows 7 OS) only:” 
on page 27)

http://www.keysight.com/
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— If the midplane board's part number reads W1312-63002, it needs 
to be replaced. Contact Keysight to order a new W1312-60376 
midplane board. Refer to “Getting Assistance from Keysight” on 
page 6. 

— If the midplane board's part number reads W1312-63095, it needs 
to be modified. Refer to “Step 12. Inspect or Modify Midplane Board 
(W1312-63095 to a W1312-63376)” on page 41.

6. N5244/5/A models (ONLY): If the subpanels need to be changed, the LED 
boards need to be rotated 180 degrees and the LED cables replaced (refer 
to “Step 10. Inspect and If Required, Replace Front Subpanel” on page 39). 
Regardless, ensure that LED boards are installed correctly and the LED 
cables (N5225-60001 (x2)) are the correct part numbers. Refer to “Step 
11. If Required, Rotate the LED Boards and Replace the LED Bias Cables 
(N5244/5A Only)” on page 40 and to the Service Guide’s “Removing and 
Replacing the Front Panel LED Boards” on www.keysight.com. If not, these 
parts should be ordered and replaced at no cost to the customer. Refer to 
Table 2 on page 15.

7. If your instrument has the minimum criteria mentioned above, or you have 
received the required parts you need, proceed to “Step 1. Copy All Unique 
Files to an External Disk Drive” on page 30.

Overview of the Installation Procedure

All instruments:

“Step 1. Copy All Unique Files to an External Disk Drive” on page 30

Instruments with Windows 7 Operating System (Windows 7 OS) only:

“Step 2. Update Windows 7 OS Instruments with A.10.40 or above” on 
page 31

Windows XP OS only: Before installing the new SSDA (N5242-60135 (for 
Version 7 CPU) or N5242-60137 (for Version 9 CPU)) with Windows 10 OS 
(i.e., Option 690 or Option 691 upgrade kit), the service center’s SSDA with 
firmware ≥A.10.40.00 must be loaded and initialized in the instrument. This 
initializes the instrument to a known stable state.

This section assumes you have completed the “Initial Instrument 
Inspection” section and verified, that all of the board assemblies meet the 
requirements for this A to B model upgrade. If not, refer to the “Initial 
Instrument Inspection” on page 22.

http://www.keysight.com/
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“Step 3. Verify Windows 7 OS with New A.10.40.00 Firmware or Greater” on 
page 32

All instruments:

“Step 4. Remove the outer covers” on page 33[

“Step 5. Remove the Power Supply Cover” on page 34

Instruments with Windows XP Operating System (Windows XP OS) 
only:

“Step 6. Install the Version 7 CPU W1312-60211 and SSDA N5242-60133 
*Service Center* Assembly with A.10.40 Firmware or Greater” on page 35

All instruments:

“Step 7. Install the *New* Power Supply Cover” on page 36

“Step 8. Power Up Your Instrument and Allow Windows 7 to Stabilize” on 
page 37

“Step 9. Remove the Front Panel Assembly” on page 37

“Step 10. Inspect and If Required, Replace Front Subpanel” on page 39

N5241/2/4/5/9A Only:

“Step 11. If Required, Rotate the LED Boards and Replace the LED Bias 
Cables (N5244/5A Only)” on page 40

All instruments:

“Step 12. Inspect or Modify Midplane Board (W1312-63095 to a 
W1312-63376)” on page 41

“Step 13. Install the Dress Panel on the New Front Panel Assembly” on 
page 43

“Step 14. Install the New Overlays on the New Front Panel Assembly” on 
page 44

“Step 15. Install the New Front Panel Assembly and the Lower Overlay” on 
page 45

“Step 16. Install New version SPAM V, Synth, IF Multiplexer, Noise Figure 
Receiver, and Test Set Mother boards (If Necessary)” on page 49

“Step 17. Install the New Handler I/O Cable” on page 50

“Step 18. Install the *NEW* N5242-60135 Solid-State Disk Drive Assembly 
(SSDA) from the Option 690 Upgrade Kit OR Install the *NEW* Version 9 CPU 
W1312-60563 and *NEW* N5242-60137 Solid-State Disk Drive Assembly 
(SSDA) from the Option 691 Upgrade Kit” on page 52

“Step 19. Reboot the Instrument” on page 53
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“Step 20. Install the Dual Cable Rear Guard (N5247B Only)” on page 55

“Step 21. Reinstall the Outer Covers” on page 56

“Step 22. Install Option N52xxAU-690 or N52xxAU–691” on page 57

“Step 23. Changing your PNA’s Computer Name from an A model to a B 
model” on page 59

“Step 24. Install and Verify Multiple License Files” on page 60

“Step 25. Verify the PNA Analyzer Program is Running with the Correct 
Options” on page 61

“Step 26. Copy the Unique Files Back to the Analyzer’s SSD” on page 62

“Step 27. Motherboard Event Log Clearing” on page 62

“Step 28. Perform Post-Upgrade Adjustments and Calibration” on page 63

“Step 29. Prepare the PNA for the User” on page 65
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-

Step 1. Copy All Unique Files to an External Disk Drive

The hard disk drive (HDD/SSD) in your analyzer will be replaced as part of this 
upgrade. Therefore, it is necessary that all unique and personal files stored on 
the HDD/SSD be saved to an external disk drive for re-installation later on the 
new SSD.

This procedure is written assuming a USB flash memory drive is used, 
although any external disk drive will suffice.

1. Connect the power cord to the analyzer and turn ON the power.

2. Insert a USB flash memory drive into a USB port.

3. Open Windows Explorer.

4. Copy all of your files that you want to transfer to the USB drive:

— If an instrument has a SSD with Windows XP: if the user has loaded 
unique calibration kit information, navigate to C:\Program 
Files\Keysight\Network Analyzer and copy USER_CALKITFILE 
to a USB flash memory drive. Also copy any personal user files that 
you wish to preserve. 

— If an instrument’s has a SSDA with Windows 7 OS: for more 
information on the N8984A SSD, refer to the Windows 7 Operating 
System Upgrade Kit Installation Note, available online at 
https://www.keysight.com/us/en/assets/9018-04311/installation-
guides/9018-04311.pdf (N8984-90001).

Obsolete. Reference only.

This section assumes you have completed the “Initial Instrument 
Inspection” section and verified, that all of the board assemblies meet the 
requirements for this A to B model upgrade. If not, refer to the “Initial 
Instrument Inspection” on page 22.

If you still need to modify your system motherboard and some of the other 
subsequent steps in the “Initial Instrument Inspection” on page 22, first, 
complete the copying of all uniques files to an external drive as indicated 
in this step and then return to complete the “Initial Instrument Inspection” 
on page 22.

You may skip this step, if you plan to retain the installed SSD for future 
access. (i.e., To connect your old SSD as a secondary drive, a USB to data 
or USB to SATA converter cable is required and these are available 
commercially).

http://literature.cdn.keysight.com/litweb/pdf/N8984-90001.pdf
http://literature.cdn.keysight.com/litweb/pdf/N8984-90001.pdf
https://www.keysight.com/us/en/assets/9018-04311/installation-guides/9018-04311.pdf
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Step 2. Update Windows 7 OS Instruments with A.10.40 or above

— If you are installing an SSDA for Windows 10: for more information 
on the N8985A SSD, refer to the Windows 10 Operating System 
Upgrade Kit Installation Note, available online at 
https://www.keysight.com/us/en/assets/9018-04733/installation-
guides/9018-04733.pdf (N8985-90001).

5. Remove the USB drive from the USB port.

6. Exit Windows Explorer.

Step 2. Update Windows 7 OS Instruments with A.10.40 or above

1. If the PNA is running, click File > Exit

2. Go to 
https://www.keysight.com/my/en/lib/software-detail/instrument-firmwar
e-software/n52xxb-pna-series-network-analyzer-firmware.html and 
download the latest PNA firmware.

3. Click on the firmware to be downloaded.

4. Save the program to disk (hard drive of your PC or to your PNA).

5. If necessary, transfer the file from your PC to your PNA using LAN, CD, or 
USB Pen drive.

6. Double-click the file on the PNA. Follow the prompts to complete the 
firmware installation.

7. If the PNA application does not start up automatically, double-click the 
network analyzer icon on the desktop. 

Skip this step, if your PNA is already running firmware A.10.40 or above.

If you have problems with updating the PNA’s firmware, refer to “Getting 
Assistance from Keysight” on page 6. 

https://www.keysight.com/my/en/lib/software-detail/instrument-firmware-software/n52xxb-pna-series-network-analyzer-firmware.html
https://www.keysight.com/my/en/lib/software-detail/instrument-firmware-software/n52xxb-pna-series-network-analyzer-firmware.html
https://www.keysight.com/my/en/lib/software-detail/instrument-firmware-software/n52xxb-pna-series-network-analyzer-firmware.html
https://www.keysight.com/my/en/lib/software-detail/instrument-firmware-software/n52xxb-pna-series-network-analyzer-firmware.html
https://www.keysight.com/us/en/assets/9018-04733/installation-guides/9018-04733.pdf
https://www.keysight.com/us/en/assets/9018-04733/installation-guides/9018-04733.pdf
https://www.keysight.com/my/en/lib/software-detail/instrument-firmware-software/n52xxb-pna-series-network-analyzer-firmware.html
https://www.keysight.com/my/en/lib/software-detail/instrument-firmware-software/n52xxb-pna-series-network-analyzer-firmware.html
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Step 3. Verify Windows 7 OS with New A.10.40.00 Firmware or Greater

-

Step 3. Verify Windows 7 OS with New A.10.40.00 Firmware or 
Greater 

1. After the new firmware is installed, verify the firmware operates without 
errors.

2. After the instrument powers up, on the toolbar click or press Help > About 
NA to verify the firmware has been updated to A.10.40.00 or greater.

3. Power down your instrument.

Skip this step, if your PNA is already running firmware A.10.40 or above.

If you have problems with updating the PNA’s firmware, refer to “Getting 
Assistance from Keysight” on page 6. 
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Step 4. Remove the outer covers

Step 4. Remove the outer covers

Remove the Outer Cover

1. Turn OFF the analyzer and disconnect the power cord.

2. With a T-20 TORX driver, remove the strap handles (item ) by loosening 
the screw (item ) on each end of each handle.

3. With a T-20 TORX driver, remove the four rear panel feet (item ) by 
removing the center screws (item  ).

4. Slide the four bottom feet (item ) off the cover.

5. Slide the cover off of the frame.

Figure 1 Outer Cover Removal (Instruments Vary—Example Only)
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Step 5. Remove the Power Supply Cover

-

Step 5. Remove the Power Supply Cover

1. On the rear panel, remove the screws (x7) and the power supply cover. 
Save the 0515-0372 (x7) screws for reuse. 

2. If you do not have a new Hi-Pot label, then you need to peel off the old 
Hi-Pot sticker and save for reuse. 

Figure 2 Hi-Pot Sticker on the Power Supply Cover
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Step 6. Install the Version 7 CPU W1312-60211 and SSDA N5242-60133 *Service 
Center* Assembly with A.10.40 Firmware or Greater

Step 6. Install the Version 7 CPU W1312-60211 and SSDA 
N5242-60133 *Service Center* Assembly with A.10.40 Firmware or 
Greater

If a instrument currently has Windows XP OS: Install the service center’s 
version 7 CPU (W1312-60211) and Windows 7 OS SSDA (N5242-60133) into 
the analyzer by referring to Figure 3 on page 35 and to your instrument’s 
Service Guise's Chapter 7 “Repair and Replacement Procedures” on 
www.keysight.com.

Figure 3 Service Center’s Solid-State Disk Drive Assembly (SSDA) with A.10.40 or 
above (N5242-60135/N5242-60137 Win 10 OS SSDA installation is similar)

IMPORTANT! 

If your instrument already has a version 7 CPU W1312-60211and the 
Windows 7 OS has been updated to A.10.40 then skip this step to “Step 7. 
Install the *New* Power Supply Cover” on page 36.

N5242-60133

http://www.keysight.com/
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Step 7. Install the *New* Power Supply Cover

-

Step 7. Install the *New* Power Supply Cover
Refer to Figure 4 and Figure 5 for this step.

1. Install the new power supply cover by reusing the 0515-0372 (x7) screws.

2. Install the KCC label (N5240-80041) as shown.

Figure 4 Install the Power Supply Cover (N5240-00012) with reused screws (x7)

Figure 5 Install the KCC label (N5240-80041)
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Step 8. Power Up Your Instrument and Allow Windows 7 to Stabilize

Step 8. Power Up Your Instrument and Allow Windows 7 to Stabilize

1. Power up your instrument, allow to a couple of minutes for Windows 7 OS 
to stabilize and verify that there are no errors.

2. Power down your instrument.

Step 9. Remove the Front Panel Assembly

1. With a 5/16-inch wrench, remove all semi-rigid jumpers (item ) from the 
front panel. s

2. With a T-10 TORX driver, remove the eight 0515-0244 screws (item ) 
from the sides of the frame. Retain these screws for later use.

3. Slide the front panel over the test ports and other front panel connectors.

4. Disconnect the front panel interface ribbon cable (item ). The front 
panel is now free from the analyzer.

If the PNA’s serial number is 4742 or below, the display and touchscreen 
may not initially work. This is normal. This issue will be fixed when the new 
front panel is installed.

If the front panel display blanking occurs, to verify your PNA boots up and 
stabilizes, connect a PC monitor to the rear video output connector and 
verify the PNA’s behavior. 

IMPORTANT! If you have already removed the instrument’s front panel 
assembly, because of a System Motherboard L1 modification, skip to “Step 
10. Inspect and If Required, Replace Front Subpanel” on page 39.

Before removing the front panel from the analyzer, lift and support the 
front of the analyzer chassis.
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Step 9. Remove the Front Panel Assembly

-

Figure 5-6 Front Panel Assembly Removal (Instruments Vary—Example Only— Shown)
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Step 10. Inspect and If Required, Replace Front Subpanel

Step 10. Inspect and If Required, Replace Front Subpanel

This section is only required, if the front subpanel is missing the four screw 
holes as shown in Figure 6. If you need to order a subpanel, refer to “Getting 
Assistance from Keysight” on page 6.

If your subpanel is missing the four screw holes indicated in Figure 6, then you 
need to replace the subpanel. Contact Keysight to order a new subpanel and 
refer to the Service Guide for your instrument that can be downloaded from 
www.keysight.com. 

Figure 6 Verifying the front subpanel screw holes

IMPORTANT! If your front panel has the screw holes shown in Figure 6 on 
page 39, skip this step. 

STOP! If you have a N5244/5A and it is necessary to replace the front 
subpanel, you will also need to rotate the LED boards and replace the bias 
cables. Refer to “Step 11. If Required, Rotate the LED Boards and Replace 
the LED Bias Cables (N5244/5A Only)” on page 40.
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Step 11. If Required, Rotate the LED Boards and Replace the LED Bias Cables 
(N5244/5A Only)

-

Step 11. If Required, Rotate the LED Boards and Replace the LED 
Bias Cables (N5244/5A Only)

Refer to the Service Guide’s “Removing and Replacing the Front Panel LED 
Boards” on www.keysight.com1. If not, these boards should be ordered and 
replaced at no cost to the customer. Refer to Table 2 on page 15.

1. When installing the new subpanels, remove and reinstall the LED boards 
after rotating them 180 degrees.

2. Replace the old LED board bias cables with the new cables (N5225-60001 
(x2)). 

IMPORTANT! If the PNA is a N5244A/45A and it was necessary to replace 
the front subpanel, you will also need to rotate the LED boards 180 
degrees and replace the bias cables. This rework is done at no cost to the 
customer. Refer to Table 2 on page 15 and to “Getting Assistance from 
Keysight” on page 6.

1. See “Downloading the Online PNA Service Guide” on page 10.

http://www.keysight.com/
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Step 12. Inspect or Modify Midplane Board (W1312-63095 to a W1312-63376)

Step 12. Inspect or Modify Midplane Board (W1312-63095 to a 
W1312-63376)

This section is only required if the Midplane board is not a W1312-63376 part 
number. If your midplane board does not require this modification, skip this 
process and continue to the next step. After this section is completed, your 
midplane board will be a W1312-63376 midplane board. Refer to Figure 7 on 
page 42.

If your instrument already has the correct W1312-63376 midplane board, 
skip to “Step 13. Install the Dress Panel on the New Front Panel Assembly” 
on page 43.

STOP!!! Please read all content before proceeding with this upgrade 
procedure. This is a complex procedure that requires Keysight support 
training, before beginning any repairs. If you have not been properly 
trained by Keysight support personnel, attempting to do this procedure 
could result in damage to the midplane board and or the instrument! See 
also Appendix A: “Midplane Board Upgrade (W1312-63095 to a 
W1312-63376),” on page  67.

If you do not have the following equipment, do not attempt to do the 
process in the Appendix, because you may damage the board or your 
instrument. Call the factory.

This process requires the following:

– Training by Keysight support personnel to perform this upgrade

– RoHS compliant soldering materials and components

– Variable power surface-mount equipment

– 10s magnifier or greater

– Else, you may damage your midplane board and or your instrument
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Step 12. Inspect or Modify Midplane Board (W1312-63095 to a W1312-63376)

-

Verify that the sticker has the “W1312-633762 part number. Refer to Figure 7.

If not, and you have read and understand the Caution on page 41, then refer to 
Appendix A: “Midplane Board Upgrade (W1312-63095 to a W1312-63376),” 
on page  67.

If you need to remove your midplane board to verify the part number, refer to 
the Service Guide for your instrument that can be downloaded from 
www.keysight.com. 

Figure 7 Verifying the midplane board number part number is: W1312-63376—Top 
Side View
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Step 13. Install the Dress Panel on the New Front Panel Assembly

Step 13. Install the Dress Panel on the New Front Panel Assembly
Install the new lower dress panel onto the new front panel using the 10 flat 
head screws (0515-1946) provided.

Figure 8 Front Dress Panel Installation



 44                                                                                                                               Installation Note N5242-90023

Description of this Upgrade
Step 14. Install the New Overlays on the New Front Panel Assembly

-

Step 14. Install the New Overlays on the New Front Panel Assembly

There should also be a nameplate overlay included with the kit that matches 
your new analyzer; the same number as the old one except it will be a “B” 
model. There are multiple overlays provided in the kit; be sure that you use the 
proper one for your analyzer. If there is not an overlay that matches your 
analyzer, contact Keysight. Refer to “Getting Assistance from Keysight” on 
page 6 of this installation note. Refer to Figure 11 on page 47.

IMPORTANT! To avoid possible damage to the lower front panel overlay 
(label), do not attempt to attach the lower front panel label until “Step 15. 
Install the New Front Panel Assembly and the Lower Overlay” on page 45, 
step 7. 
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Step 15. Install the New Front Panel Assembly and the Lower Overlay

Step 15. Install the New Front Panel Assembly and the Lower 
Overlay

1. Reconnect the ribbon cable (item ) to the A1 front panel interface board. 
Refer to Figure 9.

2. Slide the front panel over the test port connectors. Ensure that the ribbon 
cable (item ) connectors are seated.

Figure 9 New Front Panel Assembly Installation

Before installing the front panel assembly onto the analyzer, place the 
analyzer right side up and lift and support the front of the analyzer chassis.



 46                                                                                                                               Installation Note N5242-90023

Description of this Upgrade
Step 15. Install the New Front Panel Assembly and the Lower Overlay

-

3. Hand start the twelve 0515-2044 screws (item ) in the sides of the 
frame. Use new screws from the kit and those retained earlier. Do not 
torque. Refer to Figure 9 on page 45 and Figure 10.

4. Install 0515-1946 (x4) screws (item ) into lower front panel. Do not 
torque. Refer to Figure 10.

Figure 10 New Front Panel Assembly Torque Screws

5. Torque the twelve 0515-2044 screws in the order shown in Figure 9 on 
page 45.

6. Torque the two 0515-1946 (x4) screws (2-port) or four 0515-1946 screws 
(4-port) to 9 in-lbs. 4-port is shown, refer to Figure 10. 
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Step 15. Install the New Front Panel Assembly and the Lower Overlay

7. Install each of the overlays as follows (refer to Figure 11):

— Remove the protective backing to expose the adhesive.

— Carefully align the overlay to its location and gently position it.

— Once the overlay is properly positioned, press it firmly into place.

Figure 11 Front Panel Overlays Installation
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Step 15. Install the New Front Panel Assembly and the Lower Overlay

-

8. If equipped with front panel jumpers, reinstall the semi-rigid jumpers 
(Figure 12) on the front panel using a 5/16 inch torque wrench set to 
8 in-lbs (N5247B only) and 10 in-lbs (N5241/2/4/5/9B).

9. If available, install the jumper covers (not shown).

Figure 12 Install front panel jumpers
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Step 16. Install New version SPAM V, Synth, IF Multiplexer, Noise Figure Receiver, and 
Test Set Mother boards (If Necessary)

Step 16. Install New version SPAM V, Synth, IF Multiplexer, Noise 
Figure Receiver, and Test Set Mother boards (If Necessary)

A) Install the new SPAM V Boards

If your PNA already has the SPAM V boards, skip to next step.

Install the new SPAM V boards by referring to your Service Guide on 
www.keysight.com.

B) Install the new Synthesizer Boards

If your PNA already has the correct synthesizer boards, skip to next step.

Install the new synthesizer boards by referring to your Service Guide on 
www.keysight.com.

C) Install the new IF Multiplexer Board

If your PNA already has the correct IF multiplexer board, skip to next step.

Install the new IF multiplexer board by referring to your Service Guide on 
www.keysight.com.

D) Install the new Test Set Motherboard

If your PNA already has the correct test set motherboard (N5241/4/9A & 
N5264A: “N524563163”; N5244/5/7A: “N524563157”) skip to next step.

If not, install the new test set motherboard by referring to your Service Guide 
on www.keysight.com.

E) Install the new Noise Figure Receiver Board (N5241A/42A 
Option 029 only)

If an old N5242-60098 Noise Receiver board is being replaced by a new 
N5245-60124 board, install it by referring to your Service Guide on 
www.keysight.com. If your PNA already has the correct Noise Figure Receiver 

board, skip to next step.

IMPORTANT! The new Noise Figure Receiver board, also requires cables 
W141 (N5242-20322) and W143 (N5242-20323) to be ordered and 
installed. See also, Table 5 on page 23 and to “Getting Assistance from 
Keysight” on page 6.

http://www.keysight.com/
http://www.keysight.com/
http://www.keysight.com/
http://www.keysight.com/
http://www.keysight.com/
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Step 17. Install the New Handler I/O Cable

-

Step 17. Install the New Handler I/O Cable
Refer to your instrument Service Guide’s section “Remove and Replace the A19 
Test Set Motherboard” on www.keysight.com.

1. Remove the A19 TSMB and be careful to mark all of the cables before 
removal (i.e., If your TSMB needs to be replaced–if it is not N5241/4/9A & 
N5264A: “N524563163”; N5244/5/7A: “N524563157”), discard this older 
board).

2. Remove the old handler I/O cable and discard, it will not be reused.

3. Install the new I/O cable (8121-2919) using (x2) 0515-0372 screws. 
Torque to 9 lb-ins.

4.  Reinstall the A19 TSMB by reversing the procedure in the Service Guide’s 
“Remove and Replace the A19 Test Set Motherboard” section.

Figure 13 Install the Handler I/O Cable (8121-2919 and 0515-0372 (x2))

http://www.keysight.com/
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Step 17. Install the New Handler I/O Cable

Figure 14 Fold the Handler I/O Cable (8121-2919 and N5242-60005)
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the Option 690 Upgrade Kit OR Install the *NEW* Version 9 CPU W1312-60563 and 
*NEW* N5242-60137 Solid-State Disk Drive Assembly (SSDA) from the Option 691 

-

Step 18. Install the *NEW* N5242-60135 Solid-State Disk Drive 
Assembly (SSDA) from the Option 690 Upgrade Kit OR  
Install the *NEW* Version 9 CPU W1312-60563 and *NEW* 
N5242-60137 Solid-State Disk Drive Assembly (SSDA) from the 
Option 691 Upgrade Kit

If a instrument currently has successfully booted up a Version 7 CPU 
(N5242-60211) and Windows 7 with A.10.40 or greater SSDA 
(N5242-60133): then choose from one of the following:

— If a instrument has a version 7 CPU (W1312-60211) installed, BUT you 
are Installing Option 690 Windows 10 OS SSDA: Install the Windows 10 
OS SSDA (N5242-60135) into the analyzer by referring to your instrument’s 
Service Guide's Chapter 7 “Repair and Replacement Procedures” on 
www.keysight.com. 

— If a instrument is installing Option 691 Version 9 CPU (W1312-60563) 
AND Win 10 OS SSDA (N5242-60137): Install the new CPU and SSDA by 
referring to your instrument’s Service Guide's Chapter 7 “Repair and 
Replacement Procedures” on www.keysight.com.

1. Install the new SSDA in the analyzer by reversing the Hard Disk Drive 
Removal procedure in the Service Guide for your model. Refer to Figure 3 
on page 35 and to your instrument’s Service Guide on www.keysight.com.

2. Install the Win 10 sticker (9010-0350) to the rear-panel side of the SSD 
tray. 

http://www.keysight.com/
http://www.keysight.com/
http://www.keysight.com/
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Step 19. Reboot the Instrument

Step 19. Reboot the Instrument

This section contains the power up process for all of the following: 

— Option 690 and Option 691 upgrades:

— Option 690 instruments that already had a version 7 CPU 
(W1312-60211) installed, but have a newly installed Windows 10 OS 
SSDA (N5242-60135).

— Option 691 upgraded instruments with a Version 9 CPU and 
Windows 10 OS SSDA (N5242-60137).

1. Power up the instrument and allow it to run for a couple of minutes to 
stabilize.

2. Verify the instrument has the correct “A” model number and serial number 
using the embedded Keysight Licensing Manager (KLM) tool on your 
analyzer: Press Start > All Programs > Keysight Licensing Manager > 
Keysight Licensing Manager.

This verifies the instrument is working correctly, so the licenses can be 
loaded. Refer to “Obtain Multiple License Key Files” on page 9.

IMPORTANT! If you have not installed your Version 7 CPU (W1312-60211)1 
or and Windows 10 OS SSDA (N5242-60135) or your Option 691 Version 9 
CPU (W1312-60563) with Windows 10 OS SSDA (N5242-60137), refer 
back to “Step 6. Install the Version 7 CPU W1312-60211 and SSDA 
N5242-60133 *Service Center* Assembly with A.10.40 Firmware or 
Greater” on page 35.

1. The system CPU must be a version 7 or greater. Option 690 is for PNA's that already have the version 7 CPU 
installed, you must have a W1312-60211 version 7 CPU installed, to use the N5242-60135 Win 10 OS SSDA. 
If a PNA has an older CPU version that needs to be replaced, the customer will need to order the Option 691 
kit, which includes a Version 9 or greater CPU. Refer to Table 1 on page 12, Table 2 on page 15, Table 3 on 
page 18, Table 4 on page 20  and “Contacting Keysight” on page 6.

When you power up your instrument there will be many errors, because 
your instrument does not have any licenses installed. This is as expected 
and will be corrected in later steps.

IMPORTANT! The “B” firmware automatically updates the CPU BIOS. When 
the drive that comes with the upgrade kit is first booted, it is as expected 
that the PNA display is blurry for 10 to 15 seconds, then go blank and 
reset to a normal screen view. 

If your display remains blurry beyond ~15 seconds, the PNA BIOS needs to 
be manually set to 24-bit. (i.e., this display blurriness is indicated by a 
lavender background and screen text that is difficult to read.) Refer to 
Appendix B:, “Manually Setting the PNA Display to 24-Bit”.
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Step 19. Reboot the Instrument

-

3. If the instrument stabilizes and has the correct “A” model number and 
serial number, continue to the next step.

Else, if the unit still has initialization errors which look like problems that 
cannot be resolved, contact the Keysight Technologies, because the model 
and serial number need to be updated via the Keysight network. Refer to 
“Getting Assistance from Keysight” on page 6. 

If your display remains blurry, refer to Appendix B:, “Manually Setting the PNA 
Display to 24-Bit”.

If the PNA does not have the correct “A” model number or serial number, it 
means that somewhere in the process the instrument was initialized with 
the incorrect model number or serial number. For these cases, connect the 
PNA to the LAN and contact to the support team for assistance. Refer to 
“Getting Assistance from Keysight” on page 6.
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Step 20. Install the Dual Cable Rear Guard (N5247B Only)

Step 20. Install the Dual Cable Rear Guard (N5247B Only)
Install the dual cable rear guard (N5247-00027) over the two semi-rigid cables 
on the rear panel of the instrument. 

Figure 15 Install the Dual Cable Rear Guard (N5247-00027)
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-

Step 21. Reinstall the Outer Covers

Reinstall the Outer Cover

1. Slide the cover onto the frame.

2. Using a T-20 TORX driver, install the four rear panel feet (item ) by 
installing the center screws (item ).

3. Slide the four bottom feet (item ) onto the cover.

4. Using a T-20 TORX driver, install the strap handles (item ) by tightening 
the screws (item ) on both ends.

Figure 16 Outer Cover Reinstallation
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Step 22. Install Option N52xxAU-690 or N52xxAU–691

Step 22. Install Option N52xxAU-690 or N52xxAU–691
After completing this process your instrument will be a “B” model Network 
Analyzer.

Procedure Requirements

— The analyzer must be powered up and operating to perform this procedure.

— Obtain a license key file for installation of this upgrade by following the 
instructions on the supplied Software Entitlement Certificate. Refer to 
“License Key File Redemption” on page 7.

— The Network Analyzer program must not be running.

— A keyboard must be connected to the network analyzer.

— On your computer, copy the downloaded license key file to a USB memory 
device. 

Option Enable Procedure

1. Verify your PNA is powered up.

2. Insert the USB memory device into your PNA’s USB drive slot.

3. Within ~5 seconds the PNA should display a small “New Licenses 
Installed” message. 

Open a Windows Explorer window(s) and manually move your license file 
to C:\Program Files\Agilent\licensing. It may take Keysight 
License Manager an extra ~30 seconds to enable the license and 
automatically power down your PNA. 

Successful License Installation is displayed on the bottom of the 
window. 

4. If the license file installed and the PNA rebooted as expected, remove your 
USB memory device.

If your PNA does not automatically reboot, contact Keysight Technologies. 
See “Getting Assistance from Keysight” on page 6.
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-

Option Verification Procedure

Once the analyzer has restarted and the Network Analyzer program is again 
running:

1. On the analyzer, click or press to open the KLM software from your PNA’s 
Windows taskbar by pressing Start > More Programs > Keysight License 
Manager folder > Keysight License Manager.

2. If the model number, serial number and computer name (hostname) are 
correct, continue to “Step 24. Install and Verify Multiple License Files” on 
page 60.

3. If the model number, serial number are not correct, contact Keysight. 
Refer to “Getting Assistance from Keysight” on page 6.

4. If the computer name (hostname) is incorrect, proceed to “Step 23. 
Changing your PNA’s Computer Name from an A model to a B model” on 
page 59.

When you power up your instrument there will be many errors, because 
your instrument does not have any licenses installed. This is as expected 
and will be corrected in later in this procedure.

IMPORTANT! For PNAs that are still A models, proceed to “Step 23. 
Changing your PNA’s Computer Name from an A model to a B model” on 
page 59.

If the PNA does not have the correct “B” model number and or serial 
number, it means that somewhere in the process the instrument was 
initialized with the incorrect model number or serial number. For these 
cases, connect the PNA to the LAN. Refer to “Getting Assistance from 
Keysight” on page 6.
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Step 23. Changing your PNA’s Computer Name from an A model to 
a B model

If the PNA does not have a B model after the upgrade, it is necessary to run the 
ChangeHostname program to change the PNA from an A model to a B model. 

1. Open a Windows Explorer window and navigate to: 
C:\Keysight\PNA\tools\ChangeHostName

2. Right click on the ChangeHostname file and click: 
Run as administrator

The program automatically runs and terminates in ~two seconds (i.e., 
without any user interaction).

3. To verify:

On the toolbar click Help > About NA… 

And, verify that the hostname has the correct B model number.
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-

Step 24. Install and Verify Multiple License Files
After completing this process all of your license files should be loaded into your 
instrument.

Procedure Requirements

— The analyzer must be powered up and operating to perform this procedure.

— Obtain your multiple license key files by following contacting Keysight 
Technologies. Refer to “Obtain Multiple License Key Files” on page 9 and 
“Getting Assistance from Keysight” on page 6.

— The Network Analyzer program must not be running.

— A keyboard must be connected to the network analyzer.

— Use a USB memory device to download your license key file(s) to the top 
level on a USB memory device (i.e., do not move the files to a folder). 

Option Enable Procedure

1. Verify your PNA is powered up.

2. Locate the email(s) from Keysight which contain license file attachments. 
These emails are the result of “License Key File Redemption” on page 7.

3. Copy the license file(s) from the email(s) to a USB flash drive.  
More than one license file may be copied to the USB flash drive. 

4. Connect the USB flash drive to the PNA. 

Within 5 seconds, the PNA should display a small “New licenses installed” 
message.

If your license did not load automatically via USB memory device, open a 
Windows Explorer window(s) and manually move your license file to 
C:\Program Files\Agilent\licensing. It may take Keysight 
License Manager an extra ~5 seconds to enable the license and 
automatically power down your PNA. 

Successful License Installation is displayed on the bottom of the 
window. 

5. Shut down the PNA application and restart.

A single license file may contain licenses for more than one feature.

http://www.keysight.com/find/fieldfoxsupport
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Optional: Cycle power on the instrument to activate the newly installed 
option upgrade(s). (Press the power button once to power down the 
instrument.)

6. Disconnect the USB flash drive from the PNA.

Step 25. Verify the PNA Analyzer Program is Running with the 
Correct Options

Verify the Option Numbers

Verify that the Options are Enabled

Once the Network Analyzer program is again running:

1. On the analyzer, click or press to open the KLM software from your PNA’s 
Windows taskbar by pressing Start > More Programs > Keysight License 
Manager folder > Keysight License Manager and verify the options are 
correct. 

2. Press OK.

3. After successful installation of all upgrades, some features require some 
adjustments to ensure the instrument meets its specified performance. 
Refer to the following Web site: 
http://mktwww.srs.is.keysight.com/field/service/network/pna/.

Attempting to re-install a license file that is already installed may generate 
a “Corrupt Media” error message. Ignore this message.

If the options have been enabled, skip to “Step 26. Copy the Unique Files 
Back to the Analyzer’s SSD” on page 62.

If the options have not been enabled, refer to “Getting Assistance from 
Keysight” on page 6.

http://mktwww.srs.is.keysight.com/field/service/network/pna/
http://mktwww.srs.is.keysight.com/field/service/network/pna/
http://mktwww.srs.is.keysight.com/field/service/network/pna/
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Step 26. Copy the Unique Files Back to the Analyzer’s SSD

The files that were previously saved onto a USB flash memory drive must 
now be installed onto the new SSD.

— For a list of possible files (and their directory paths), refer to one of these 
installation notes:

— Windows 7 
https://www.keysight.com/us/en/assets/9018-04311/installation-
guides/9018-04311.pdf

— Windows 10

https://www.keysight.com/us/en/assets/9018-04733/installation-
guides/9018-04733.pdf

1. Connect the power cord to the analyzer and turn ON the power.

2. Insert the USB flash memory drive into a USB port.

3. Open Windows Explorer.

4. Navigate to:

— Data and state files storage: D:\
— Support files: c:\programdata\Keysight\network 

analyzer
5. After all files have been copied, remove the USB flash memory drive from 

the USB port.

6. Exit Windows Explorer.

Step 27. Motherboard Event Log Clearing
Perform the clearing the event Log step described in Appendix , “2. Clearing 
the Event Log and Verifying the Motherboard Modification Removed the USB 
Errors (2152).”

https://www.keysight.com/us/en/assets/9018-04311/installation-guides/9018-04311.pdf
https://www.keysight.com/us/en/assets/9018-04311/installation-guides/9018-04311.pdf


Installation Note N5242-90023                                                                                                                                  63

Description of this Upgrade
Step 28. Perform Post-Upgrade Adjustments and Calibration

Step 28. Perform Post-Upgrade Adjustments and Calibration

Adjustments

The following adjustments must be made due to the hardware changes of the 
analyzer.

— 10 MHz frequency reference adjustment

— EE default adjustment (Only, if the synthesizer board is changed)

— synthesizer Bandwidth adjustment (Only, if the synthesizer board is 
changed)

— source adjustment

— IF gain adjustment

— receiver adjustment

— receiver characterization

— IF response adjustment (Option S93090xA/B, S93092A/B, S93093A/B, or 
S93094A/B Only)

— Noise Adjustment (Option 029 with S93029A Only)

These adjustments are described in the PNA Service Guide and in the PNA 
on-line HELP. A list of equipment required to perform these adjustments is also 
found in the service guide1.

After the specified adjustments have been performed, the analyzer should 
operate and phase lock over its entire frequency range.

Else, all adjustments must be run per the instrument’s Service Guide on 
www.keysight.com.

EEPROM Backup

The analyzer uses arrays of correction constants to enable the analyzer to 
produce accurate, leveled source signals and receive clean test signals. These 
constants are stored in non-volatile EEPROM memory and in flash memory 
files.

IMPORTANT!

The 10 MHz reference crystal oscillator is the most accurate after running 
for three hours. The 10 MHz Frequency Reference Adjustment can be run 
after the PNA has warmed up for 90 minutes, and the other adjustments 
can be completed in the order presented, but then the 10 MHz Frequency 
Reference Adjustment should be repeated after the PNA has been able to 
warm up for three hours.

1. See “Downloading the Online PNA Service Guide” on page 10.

http://www.keysight.com/
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The adjustments listed here generate new correction constants. The analyzer 
must have a backup of this new data in case any of the data becomes 
corrupted.

To store the backup data, perform these steps:

— Navigate to the EEPROM Backup Utility, located at: 

— Windows 7 -- C:\Program Files (x86)\Keysight\Network 
Analyzer\Service\eebackup.exe

— Windows 10 -- C:\Program Files\Keysight\Network 
Analyzer\Service\eebackup.exe

— Run the program.

— Click Backup EEPROM.

— Click Backup TSMB Mem.

— Click Backup Synth Mem. (Applies to Version 7 Synthesizers Only)

— Click Exit when the program has finished.

Figure 17 EEPROM Backup Menu

Operator’s Check

Perform the Operator’s Check to check the basic functionality of the analyzer. 
For instructions, refer to the “Tests & Adjustments” chapter of the Service 
Guide.

If you experience difficulty with the basic functioning of the analyzer, contact 
Keysight. Refer to “Getting Assistance from Keysight” on page 6.



Installation Note N5242-90023                                                                                                                                  65

Description of this Upgrade
Step 29. Prepare the PNA for the User

Calibration

Although the analyzer functions, its performance relative to its specifications 
has not been verified. It is recommended that a full instrument calibration be 
performed using the N7840A performance test software or the instrument’s 
embedded performance tests. Refer to the analyzer’s service guide for 
information on the performance test software.

Step 29. Prepare the PNA for the User

1. If necessary, reinstall front jumper cables.

2. Install the cable guards, pushing them over the front jumper cables until 
the cushioning material touches the front panel of the PNA.

3. Install the dust caps on the test ports.

4. Install labels included in kit as required (e.g., KCC, two person Caution).

5. Clean the analyzer, as needed, using a damp cloth.
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Installation Note

A: Midplane Board Upgrade (W1312-63095 to a 
W1312-63376)

This section is only required if the Midplane board is not a W1312-63376 part 
number. If your midplane board does not require this modification, skip this 
process and continue to the “Step 13. Install the Dress Panel on the New Front 
Panel Assembly” on page 43. After this section is completed, your midplane 
board will be a W1312-63376 midplane board. Refer to Figure A-6 on page 74.

STOP!!! Please read all content before proceeding with this upgrade 
procedure. This is a complex procedure that requires Keysight support 
training, before beginning any repairs! If you have not been properly 
trained by Keysight support personnel, attempting to do this procedure 
could result in damage to the midplane board and or the instrument! See 
also “Step 12. Inspect or Modify Midplane Board (W1312-63095 to a 
W1312-63376)” on page 41.

If you do not have the following equipment, do not attempt to the process 
in the Appendix, because you may damage the board and or your 
instrument. Stop and return the instrument to Keysight for repair. Refer to 
“Getting Assistance from Keysight”.

This process requires the following: 

— Training by Keysight support personnel to perform this upgrade

— RoHS compliant soldering materials and components

— Variable power soldering iron for surface-mount components

— 10x magnifier or greater

— Else, you may damage your midplane board and or your instrument
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Table A-1 Parts List for Midplane Board Upgrade Kit Modificationa

Part number Description

0699-1429 Resistor U403—383 ohm (attach to pin 5)

216–2632GR005
–NDb

32 AWG wire (Operating temperature 300C) – (0.5 inch)

5184-4489 Label-Brady blank label

0470-0954 Loctite 495

a. The factory will provide these items upon request.
b. This spool of 32 AWG 100’ (30.5m) wire part number can be ordered from Digi-Key here:
 https://www.digikey.com/en/prod-

ucts/detail/alpha-wire/2632-GR005/15194125. 

https://www.digikey.com/en/products/detail/alpha-wire/2632-GR005/15194125
https://www.digikey.com/en/products/detail/alpha-wire/2632-GR005/15194125
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Procedure

1. To remove your midplane board, refer to the Service Guide for your 
instrument that can be downloaded from www.keysight.com.

2. Cut pin 5 on U403, so that half of the lead is left near on the IC. Refer to 
Figure A-1.

Figure A-1 Step 1 Cut pin 5 half way up as shown—Top Side View
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3. Clean pad and remove cut off portion of U403–pin 5 from the pad. Refer to 
Figure A-2.

Figure A-2 Cleaning the pad for pin 5—Top Side View
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4. Add 383 ohm resistor as shown. Refer to Figure A-3.

Figure A-3 Add 383 ohm resistor
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5. Add a 1/2 inch 32 gauge wire. Refer to Figure A-4.

Figure A-4 Add a 1/2 inch 32 gauge wire—Top Side View
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6. Add glue as shown to hold the wire in place. Refer to Figure A-5 on 
page 73.

Figure A-5 Add glue as shown to hold the wire in place—Top Side View 
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7. Add the W1312-63376 sticker. Verify that the sticker does not interfere 
with the PCA screw holes. Refer to Figure A-6.

Figure A-6 Adding sticker to new board number W1312-63376—Top Side View

8. Re-install the midplane board per the Service Guide for your instrument 
that can be downloaded from www.keysight.com. 
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B: Manually Setting the PNA Display to 24-Bit

This section is only required if, after installing the new SSD that comes with 
this upgrade kit (refer to “Step 18. Install the *NEW* N5242-60135 
Solid-State Disk Drive Assembly (SSDA) from the Option 690 Upgrade Kit OR 
Install the *NEW* Version 9 CPU W1312-60563 and *NEW* N5242-60137 
Solid-State Disk Drive Assembly (SSDA) from the Option 691 Upgrade Kit” on 
page 52), your PNA reboots and does not automatically adjust the display to 
24-bit. If your PNA does not have a blurry display, skip this process and 
continue to the “Step 21. Reinstall the Outer Covers” on page 56. 

Procedure
In this procedure, you will need to navigate through the PNA’s BIOS menu, 
even though you are unable to clearly read the menus.

1. During the bootup of your PNA: Press F7 on bootup until the BIOS screen 
opens.

2. In the window that opens, the top row of the screen will have various menu 
selections: Main, Advanced, Chipset, Boot, Security, and Save&Exit.

Use the arrow keys to move the selection from Main over to Chipset, then 
press Enter.

3. In the window that opens, the first of three rows should be have white text 
which says Graphics Configuration. With this row highlighted, press Enter.

4. In the window that opens, use the down arrow to move the selected text to 
the bottom row: LCD Control. Press Enter.

5. In the window that opens, use the down arrow to move the selected text to 
the bottom row: Panel Color Depth. Press Enter. 

6. At this point, a small blue box with two items pops up. The top one is “18 
bit”, the bottom one is “24 bit”. Select this bottom one and press Enter.

7. Now press F10 (to Save & Exit).
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C: Motherboard Clearing the Event Log and Modification 
to Replace L1

This section is required to modify the following motherboard p/n’s: 
N5230-63133, N5242-63151, and N5247-63002. This modification is required 
to avoid USB 2152 errors, which indicates intermittent USB connections in the 
instrument. Refer to Table A-1, “Models and Motherboards for L1 
N5240-60111 Jumper Wire Modification.” 

STOP! 
Any return to factory (RTF) that will have CPU, Midplane, Motherboard, 
Front Panel, or Front Panel Ribbon replaced will need to have it's event log 
cleared after the hardware replacements are complete. 

Older System motherboards with serial numbers 
<N5247-63002-23-1945-00002 need to be reworked to remove L1, per 
Appendix C:, “Motherboard Clearing the Event Log and Modification to 
Replace L1.” If you have an older system board, call Keysight Support to 
verify, if your instrument has previously been upgraded. Refer to “Getting 
Assistance from Keysight” on page 6.

Refer to Refer to Table 5, “Overview of Assembly Requirements for B Model 
Upgrade,” and Appendix C:, “Motherboard Clearing the Event Log and 
Modification to Replace L1.”

IMPORTANT! 
Any return to factory (RTF) that has its CPU, Midplane, Motherboard, Front 
Panel, or Front Panel Ribbon replaced, will need to have it's event log 
cleared after the hardware replacements are complete.

Table A-1 Models and Motherboards for L1 N5240-60111 Jumper Wire Modification

Model Number System Motherboard p/n

N5239A/B, N5231A/B, N5232A/B, N5234A/B, 
N5235A/B

N5230-60133

N5249A/B, N5241A/B, N5242A/B, N5264A/B, 
N5221A/B, N5222A/B

N5242-60151
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Procedures
This section contains the following:

“1. System Motherboard Modification”

“2. Clearing the Event Log and Verifying the Motherboard Modification 
Removed the USB Errors (2152)”

“3. After Completing Event Log Check Instructions”

1. System Motherboard Modification

These procedure assumes you have disassembled the instrument and have 
removed the system motherboard from the chassis.

This procedure shows how to remove L1 and to replace it with some green 
wires connecting the motherboard traces.

1. Locate L1 on the motherboard. Refer to Figure A-1 on page 79.

2. Remove L1 using a surface mount soldering iron and appropriate tip or use 
two soldering irons. Refer to Figure A-2 on page 79.

3. Clean motherboard traces. Refer to Figure A-2 on page 79.

4. Prepare green wire (x3). Refer to Figure A-3 on page 80.

5. Solder green wire x3 to L1 traces. Refer to Figure A-4 on page 81.

N5244A/B, N5245A/B, N5247A/B, N5224A/B, 
N5225A/B, N5227A/B

N5247-60002

Table A-2 Tools for N5240-60111 Jumper Wire Modification

Description Part Number

Jumper wire N5240-60111

Solder (Lead free) ––

Soldering iron ––

Surface mount iron and tips (Optional, but 
recommended)

––

Table A-1 Models and Motherboards for L1 N5240-60111 Jumper Wire Modification

IMPORTANT! 
When DONE with the three procedures in this section, return to “Step 6. 
Install the Version 7 CPU W1312-60211 and SSDA N5242-60133 *Service 
Center* Assembly with A.10.40 Firmware or Greater” on page 35.
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6. Mark motherboard as shown with black dot. Refer to Figure A-5 on 
page 81.

Figure A-1 Locate L1 on System Motherboard

Figure A-2 Remove L1 and Clean Traces
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Figure A-3 Prepare Green Wire (x3)
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Figure A-4 Solder Green Wires (x3) to Motherboard

Figure A-5 Mark the Motherboard Serial Number Label With a Black Dot
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2. Clearing the Event Log and Verifying the Motherboard Modification 
Removed the USB Errors (2152)

This section clears the event logs and runs a *.bat (CheckEventID.bat) file 
to verify the motherboard repairs are correct. In this procedure, you will need to 
navigate through the PNA’s Event Viewer menu, even though you may not be 
able to clearly read the menus.

1. Press the Win + R keys to open the Run dialog box. 

2. Type eventvwr.msc into Run, and then click/tap on OK to open the Event 
Viewer window.

3. Select a log (ex. Application) that you want to clear in the left pane of the 
Event Viewer, and click/tap on Clear Log... in the far right Actions pane. 
(i.e., see screenshot in Figure A-6, “Using the Event Viewer to Clear an 
Event Log,”).

Figure A-6 Using the Event Viewer to Clear an Event Log
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4. Using the Windows Run window, used in step 1, the *.bat file 
(CheckEventID.bat) can be run to verify that there are no 2152 error events 
(i.e., this takes ~three seconds to run).

For a CheckEventID.bat results example, refer to Figure A-7 on page 83.

Figure A-7 CheckEventID.bat to Verify Instrument USB Drives are Error Free

3. After Completing Event Log Check Instructions

After completing this procedure:

— If your instrument passed Event Log check, refer to “Step 28. Perform 
Post-Upgrade Adjustments and Calibration” on page 63.

— If your instrument FAILed the Event log check (i.e., EventID 2125 detected) 
and you had to complete the system motherboard modification (“1. System 
Motherboard Modification” on page 78), then refer to the Service Guide for 
your model to reassemble your instrument.

STOP! 
If the instrument fails the event log clearing procedure in this section by 
displaying an “EventID 2152” (USB error), older System motherboards with 
serial numbers <N5247-63002-23-1945-00002 need to be reworked to 
remove L1, per “1. System Motherboard Modification” on page 78 in this 
Appendix. If you have an older system board, call Keysight Support to 
verify, if your instrument has previously been upgraded. Refer to “Getting 
Assistance from Keysight” on page 6.
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a. After re-assembly and associated checks in the Service Guide, when 
your instrument powers up successfully, complete “2. Clearing the 
Event Log and Verifying the Motherboard Modification Removed the 
USB Errors (2152)” on page 82.

b. If your instrument passed Event Log check, refer to “Step 28. Perform 
Post-Upgrade Adjustments and Calibration” on page 63.
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